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Laboratory 1 

Scientific Calculations and Basic Lab Techniques 

 

The purpose of this laboratory session is to introduce the Cell Biology Laboratory course and to organize 

students into groups for the rest of the semester.  The basic calculations and techniques presented in this lab will 

be used in many of the later experiments.   

 

In this lab, we will: 

 

 discuss the syllabus for the course 

 go through the general procedures for lab safety 

 review the guidelines for laboratory reports 

 organize the students into lab groups 

 practice some of the scientific calculations that will be used throughout the semester 

 practice some basic laboratory methods such as the use of balances, pipets, and micropipetters. 

 introduce you to some of the basic features of the Microsoft Office Excel (2010 version) spreadsheet and 

data processing software package 

 demonstrate the use of Excel to organize and process data 

 look at the ways in which Excel can be used to create different types of graphs 

 

Please read the sections on Scientific Calculations and Basic Laboratory Techniques before the lab session.  

We will work through the calculations and the practice exercises during the lab.  While the answers to the 

practice problems are given at the end of this portion of the lab manual, you should complete all of the steps in 

each calculation.  Similar calculations may be included on the Data Sheet or the next lab quiz.   
 

The following is a flow chart for this laboratory session: 

 

Introduction to the Lab 

 

Organization of Lab Groups 

 

Review of Basic Calculations (Section I) 

 

Measuring Mass or Weight (Section IIA) 

 

Measuring Volume (Sections IIB, IIC, IID, IIE) 

 

Preparing Solutions (Section IIF) 

 

Making Dilutions (Section IIG) 

 

Using Standard Curves (Section III) 

 

Using Excel (Section IV) 
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I. Review of Scientific Calculations 

 
The prerequisites for this course include one year of General Biology with laboratory and one year of 

General Chemistry with laboratory.  This section reviews the metric system of units and some of the basic 

scientific calculations that were, in most cases, covered in those courses.   
 

A. The Metric System 

 
Scientists throughout the world use the metric system of units.  This section summarizes these units and 

gives some of the common conversion factors between metric units and their American/English 

equivalents. 

 
1. Metric prefixes.  The following prefixes often occur before units of length, weight, or 

concentration. 
 

prefix decimal form 
exponential 

form 
abbreviation 

mega- 1,000,000 10
6 M 

kilo- 1,000 10
3 k 

deci- 0.1 10
1 d 

centi- 0.01 10
-2 c 

milli- 0.001 10
-3 m 

micro- 0.000001 10
-6 μ 

nano- 0.000000001 10
-9 n 

pico- 0.000000000001 10
-12 p 

femto- 0.000000000000001 10
-15 f 

 

 

2. Units of length.  The basic unit of length is the meter, which is abbreviated m. 
 

1.0 meter (m)  = 3.28 feet  = 1.09 yards 

1.0 centimeter (cm)  = 0.01 m = 0.394 inches (1.0 inch = 2.54 cm) 

1.0 millimeter (mm)  = 0.1 cm  = 0.001 m 

1.0 micrometer (μm)  = 0.001 mm 

1.0 nanometer (nm)  = 0.001 m  = 10 Angtroms (A) 

 

3. Units of mass.  The basic unit of mass is the gram, which is abbreviated g.  Mass and weight 

are often used interchangeably, but they have somewhat different meanings.  Mass is an 

inherent property of an object, while weight reflects the force of gravity on the Earth at a 

certain atmospheric pressure.  An astronaut who has a mass of 150 pounds weighs about 150 

pounds on Earth.  However, even though that person has the same mass in space, his/her 

weight is 0 because there is no gravitation field.  
 

1.0 kilogram (kg)  = 1000 g   = 2.2 pounds 

1.0 g    = 0.0353 ounces 

1.0 milligram (mg)  = 0.001 g 

1.0 microgram (μg)  = 0.001 mg 
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4. Units of volume.  The basic unit of volume is the liter, which is abbreviated l or L. 

 

1.0 liter   = 1.06 quarts 

1.0 ml    = 0.001 liter 

1.0 μl    = 0.001 ml 

 

5. Units of amount.  The basic unit of the amount of a chemical substance is the mole, which is 

sometimes abbreviated mol.  A mole is 6.023 x 10
23

 (Avogadro's number) of molecules of a 

substance.  The mass of this number of molecules in grams is referred to as the gram 

molecular weight.  The gram molecular weight of NaCl is 58.44, so 58.44 grams represents 

1.0 mole or 6.023 x 10
23

 molecules of this chemical.  Some chemicals are produced in a form 

in which a certain number of water molecules are bound to each molecule of the compound 

of interest (for example, FeCl3.6H2O).  In the case, the mass is most often expressed as the 

formula weight (FW). 

 

1.0 millimole (mmol)  = 0.001 mole 

1.0 micromole (μmol) = 0.001 mmole  

1.0 nanomole (nmol)  = 0.001 μmole 

 

B. Conversion of Units 
 

It is often necessary to move back and forth between different metric units or between metric and 

American/English units.  While you can often do this in your head, the best way to ensure that you have 

done the calculation correctly is through the use of conversion factors.  This is sometimes called 

dimensional analysis.  A conversion factor is simply a ratio that expresses the relationship between two 

units.  Either unit may be used in the numerator or the denominator, depending on the calculation 

required.  For example, there are 2.54 cm in an inch, so this can be written as either  
 

2.54 cm or  1 inch 

inch   2.54 cm 

 

One reason for doing a conversion of units is to express numbers as simply as possible.  It is easier to 

understand a number expressed as 8.37 than it is a number written as 8,370,000,000 or as 0.00000837.  

In the case of 8,370,000,000, it would be better to use a larger unit.  Instead of saying you have 

8,370,000,000 nanometers, it is better to say you have 8.37 meters.  In the case of 0.00000837, it would 

be better to use a smaller unit.  Instead of saying you have 0.00000837 meters, it is better to say you 

have 8.37 micrometers. 

 
As an alternative to changing units, you can also write very large or very small numbers in scientific 

notation as a power of 10.  For example, the number 8,370,000,000 nanometers can be written as 8.37 x 

10
9
 nm and the number 0.00000837 meters can be written as 8.37 x 10

-6
 m.   

 

1. Interconversion of metric units.  Suppose you have measured an object and found that it is 

3.7 cm long.  

 

a. What is the length of the object in meters (m)?  

 

b. What is the length of the object in millimeters (mm)?  

 

c. What is the length of the object in nanometers (nm)?   
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To make these conversions, multiply the given value by the appropriate conversion factor.  For 

example, 

 

a. 3.7 cm   x 1 meter = 3.7 meter = 0.037 m 

  100 cm   100 

 

b. 3.7 cm  x 10 mm  = 3.7 x 10 mm = 37 mm 

1 cm 

 

c. 3.7 cm  x 1 meter x 10
9
 nanometer = 3.7 x 10

7
 nm 

  100 cm   1 meter 

 

Notice that you always cancel out the unneeded units so that the final value is expressed in the 

desired units.  If you cannot remember a specific conversion factor (for example, between cm 

and nm), you can always use conversion factors that relate each unit to the basic unit of 

measurement, a meter, and then multiply through by all of these conversion factors. 

 

2. Practice problems.  Record your complete calculations in your lab notebook. 
 

a. How many mm are there in 5.5 cm? 

 

b. How many cm are there in 5.5 m? 

 

c. How many m are there in 555 mm? 

 

d. How many cm are there in 555 m? 

 

e. How many nm are there in 555 m? 

 

f. How many ml are there in 0.042 L? 

 

g. How many l are there in 42 ml? 

 

h. How many l are there in 420 ml? 

 

i. How many g are there in 754 ng? 

 

j. How many ng are there in 7.54 mg? 

 

k. How many kg are there in 7.54 x 10
5
 mg? 

 

 

3. Interconversion of metric and English units.   Suppose you have measured the weight of 

object and find that it is 1.85 pounds.  

 

a. What is the weight of the object in kilograms?  

 

b. What is the weight of the object in grams?  

 

c. What is the weight of the object in nanograms? 
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  Again, you can solve this type of problem by using the appropriate conversion factors. 

 

a. 1.85 pounds x 1 kilogram = 1.85 kilogram  = 0.841  kg 

      2.2 pounds  2.2 

 

b. 1.85 pounds  x 1 kilogram x 1000 gram  

2.2 pounds  1 kilogram 

 

= 1.85 x 1000 gram = 841 g 

2.2 

 

c. 1.85 pounds x 1 kilogram x 1000 gram x 10
9
 nanogram 

2.2 pounds  1 kilogram  gram 

 

= 1.85 x 1000 x 10
9
 nanogram = 8.41 x 10

11
 ng 

2.2 

 

4. Practice problems.  Record your complete calculations in your lab notebook. 
 

a. How many inches are there in 16.3 cm? 

 

b. How many m are there in 16.3 inches? 

 

c. How many mm are there in 1.63 inches? 

 

d. How many feet are there in 163 cm? 

 

e. How many mg are there in 2.27 ounces? 

 

f. How many ounces are there in 2.27 gram? 

 

g. How many g are there in 2.27 pounds? 

 

h. How many kg are there in 227 pounds? 

 

i. How many ml are there in 1.98 quarts? 

 

j. How many l are there in 198 gallons? 

 

k. How many ml are there in 1.98 gallon? 

 

C. Significant Figures 
 

An important issue in any calculation is the number of significant figures.  Most electronic calculators 

will give numbers with 8 digits, such as 23463864 or 22.056948.  Are all of these figures significant and 

should they be included in your calculations?  The short answer is no.  For most scientific calculations, 

the key issue is the accuracy of the instruments used in a particular measurement.  For example, the 

balances you will use in today's lab are only designed to weigh material to 0.01 g.  While you can report 

a measurement of 12.67 g, you cannot assume a higher level of accuracy and say there were 12.67003 g.   
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Suppose you repeated a particular weight measurement five times and found values of 12.67, 13.01, 

12.40, 12.93, and 13.08.  You should report that the average is 12.82, even if your calculator displays a 

value of 12.818.  You should round up to the next higher number if the third digit to the right of the 

decimal point is =/>5 and round down if the third digit is < 5.  Likewise, a P-100 micropipetter 

(described below) that is used to transfer small volumes of liquid has only 3 digits on the dial, so if you 

set it to 0 7 4, you can report that you used 74 μl of solution, but not 74.034 μl of solution.  

 

For most of the calculations in this course, it will be sufficient to include 2 digits to the right of a 

decimal point (for example, 12.67 g), or just two digits if it is a number less than 1.0 (for example, 

0.0013).  If you make measurements with several different instruments, the number of significant figures 

is determined by the accuracy of the least accurate instrument. 

 

II. Basic Laboratory Techniques 
 

A. Measuring Mass or Weight 
 

The mass of an object is normally determined by weighing a sample on a laboratory balance.  

Technically, mass is an inherent property of an object while weight is the apparent mass of an object 

under certain gravitational forces or atmospheric forces.  Since we are relatively close to sea level in 

Arizona, we will take the weight of an object to be the same as its mass in this course 

 
1. Top Loading Balances 

 

Most laboratory measurements of mass or weight are made on relatively simple top-loading 

balances.  Each balance has a metal pan on which samples to be weighed can be placed and a digital 

display that shows the weight of the object in grams.  The display allows you to read the weight of 

an object to 0.01 g.  While the display can be set to display weights in ounces or grams, we will only 

use the metric units in this course.   

 

In using these balances, always place a plastic weighing dish, a beaker, or glassine paper on the 

metal pan and then place your sample on this container.  Never place samples, particularly 

chemicals, directly on the metal pan because they can cause corrosion.  These balances have a "tare" 

or "rezero" function, which means that after placing the weighing dish, beaker, or paper on the metal 

pan, you can reset the display to 0.00.  In this way, you can directly measure the weight of the 

sample of interest.  Look closely at the balance at your station and familiarize yourself with its 

controls. 

 

2.  Measuring the Weight of Solids  

 

a. Set the balance to 0.00.  Then place a plastic weighing dish on the balance.  Record the 

weight of the dish below. 

 

weight of dish  =  __________ 

 

Now press the reset or tare key and set the balance to 0.00. 

 

b. To determine the consistency of weight measurements, measure the weights of 10 individual 

pinto bean seeds.  Using a forceps, place each seed individually onto the weighing dish and 
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record its weight in the table shown below.  Use the tare function to reset the balance to 0.00 

after adding each seed.  Record the results in the following chart. 

 

Seed Weight (g) 
1  

2  

3  

4  

5  

6  

7  

8  

9  

10  
 

c. Now calculate the arithmetic mean of the seed weights.  The mean or average can be 

calculated by adding the individual values together and then dividing by the total number of 

values.   

 

The formula for the mean (X) is  

 

mean (X) = Σ xi 

         N 

 

where Σ indicates sum, xi indicates the individual value, and N indicates the total number of 

values. 

 

d. In this case, since there are weight values for 10 seeds, you would total up the ten individual 

values and divide by 10.  Record the result below.  

 

mean = __________ 

 

e. Now calculate the variance (s
2
) and the standard deviation (SD) of the seed weights.  These 

values give you a sense of how variable the data in a particular set of measurements actually 

are. 

 

The variance is determined using the following formula: 

 

s
2
 = Σ (X –xi)

2
 

N-1 

 

It is calculated by subtracting each individual value (xi) from the mean (X), squaring it (so 

that all values are positive), and adding all of these squared deviations from the mean 

together.  The total is then divided by N-1. 

 

f. The standard deviation (SD) is the square root of the variance. 

              ___________ 

SD = s = √ variance 
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The actual calculations of means, variances, and standard deviations can be done either with 

a standard laboratory calculator or using a spreadsheet program such as Excel.  

 

g. Give the variance and standard deviation of the pinto bean seed weights. 

 

variance  = __________ 

 

standard deviation = __________  

 

h. Now repeat the weight analysis using one of the other types of beans or other dried seeds 

available in the lab. 

 

Type of seed _________________________ 

 

Seed Weight (g) 
1  

2  

3  

4  

5  

6  

7  

8  

9  

10  
mean   = __________ 

 

variance   = __________ 

 

standard deviation = __________ 

 

 

 

B. Measuring Volume 
 

1. Graduated Cylinders 

 

There are several different ways to measure the volume of a liquid or to transfer a specific volume of 

liquid from one container to another.  For relatively large volumes (greater than 10 ml), graduated 

cylinders are most often used.  A graduated cylinder has markings on the side of the glass or plastic 

which indicate the volume.  Depending on the total capacity of the cylinder, the meaning of the 

markings will vary.  For a 10 ml, 25 ml, or 50 ml cylinder, they are most often 1 ml apart.  For a 250 

ml or 500 ml cylinder, they are most often 10 ml apart.  One of the problems with most cylinders is 

that an aqueous solution (that is, one made up in water) often shows a pronounced meniscus or 

curvature when it is placed in the cylinder.  This is due to the binding of water molecules to one 

another and to the sides of the glass.  The volume in a cylinder is read most accurately by looking at 

it straight on and reading the volume at the bottom of the meniscus (Figure 1).  A graduated cylinder 

can be used either to measure the volume of unknown solution or to measure out a certain volume of 
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solution and then to transfer it to another container.  Note that measurements with a cylinder are 

most accurate when the scale is viewed straight (as in b) on rather than on an angle (as in a or c). 

 

 

   
Figure 1.1. Picture of a graduated cylinder showing the 

meniscus and the best way to read the volume (b) rather than 

(a) or (c). 

2. Pipets 

 

For intermediate volumes (between 1 ml and 25 ml), pipets are most often used to transfer liquids 

from one container to another.  A pipet is a calibrated piece of glass or plastic tubing with markings 

along the side.  Again, depending on the total capacity of the pipet, the meaning of the markings will 

vary.  For a 1 ml pipet, the markings may be either 0.1 ml or 0.01 ml apart.  For a 5 ml or 10 ml 

pipet, the markings are usually 0.1 ml apart.  Each pipet usually is marked at the top so that the 

gradations are clear: it will say 5 in 1/10 ml or 1 in 1/100 ml.  As with graduated cylinders, there is 

often a meniscus with aqueous solutions.  A certain volume of liquid may be transferred from one 

container to another by drawing the liquid up into the pipet and then allowing a volume of liquid 

between two specific markings to flow out.   

 

Mohr or measuring pipets (a) are calibrated only to a point near the bottom of the glass tube.  A 

specific volume is delivered by measuring the amount of liquid between two markings.  Serological 

pipets (b) are calibrated all the way to the tip and so must be "blown out" in order to deliver all of 

their volume (Figure 1.2). 

 

 

 

 

Figure 1.2. Picture of a Mohr pipette (a) and a Serological pipette (b) 
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To use a pipet, it is necessary to draw liquid up into it.  In the past, this was often done by sucking on 

the end of the tube with your mouth (as with a straw) and covering the end with your index finger.  

However, this type of mouth pipetting is no longer considered safe and various types of bulbs, pipet 

aids, or propipets are used instead.  MOUTH PIPETTING IS NOT ALLOWED IN THE 

COURSE.  In this class, plastic pipet pumps will be used (Figure 1.3). 

 

 

 

 

A green pump should be used with 5 ml or 10 ml pipets; a blue pump should be used with 1 ml 

pipets.  To use this type of pump, insert the top end of the pipet into the pump and twist it so that it 

seals against the plastic.  Then rotate the plastic wheel to draw the liquid up into the pipet.  To let 

liquid out of the pipet, rotate the wheel in the opposite direction.  Pipets are most often used to 

transfer a certain volume of liquid from one container to another, although with care they also can be 

used to measure the volume of a solution. 

 

 

3. Micropipetters 

 

For small volumes (1.0 ml = 1000 μl or less), calibrated 

micropipetters are most often used.  In this course, a type of 

micropipetter called a Finn Pipet and sold under the name of a 

FisherBrand micropipetter will be used.  A diagram of a 

similar type of instrument is shown in figure 1.4. 

     

 

Micropipetters come in various sizes.  For the pipetters to be 

used in this course, a P-1000 is used to transfer from 100 μl to 

1000 l (1.0 ml) of liquid, a P-100 is used to transfer from 10 μl 

to 100 l (0.1 ml) of liquid, and a P-10 is used to transfer up to 

10 l of liquid.  It is important to use the appropriate pipetter for 

each needed volume.  Never try to set a pipette above or below 

the maximum or minimum limits.  A plastic pipet tip should 

always be used with these pipetters.  Sterile pipet tips will be 

provided in plastic boxes.  Use the larger blue or white tips 

for the P-1000 pipetters and the smaller yellow or white 

tips for the P-100 and P-10 pipetters. 

 

 

 

Figure 1.3. Picture of a pipette aide and 

illustration of proper use. 

Figure 1.4. Parts of a Pipette 
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To set a P-1000 to a certain volume, look at the digital display on the side and rotate the inner wheel.  

There are four numbers on the display.  For example, to set the pipetter to 1000 l, set the display to 1 

0 0 0 by turning the wheel.  To set the pipet to 650 l, rotate the wheel to set the display to 6 5 0.  

Never rotate the wheel so that the reading is over 1 0 0 0 or under 1 0 0.  To set a P-100 to a certain 

volume, again look at the digital display on the side and rotate the inner wheel.  To set the pipetter to 

100 l, set the display to 1 0 0 by rotating the wheel.  To get a volume of 72 l, set the display to 7 2 by 

rotating the wheel.  Again, never rotate the wheel so that the display is over 1 0 0 or under 1 0.  To 

set a P-10 to a certain volume, look at the display and rotate the inner wheel in the same way.  

However, in this case, the last digit on the display indicates 0.1 l.  To set the pipetter to 10 l, set the 

display to 10.0.  To get a volume of 2 l, set the display to 0 2.0.  Note that 0 0.2 indicates 0.2 l, a 

volume you will not use in this course.  You can set the P-10 micropipetter to intermediate volumes: 

6.7 is used to deliver 6.7 l. 
 

 

To use a pipetter, place a plastic tip on the end and depress the plunger button just to the first 

stop (Figure 1.5).  Draw the desired liquid up into the pipet tip by slowly allowing the plunger 

button to return to its original position.  DO NOT "POP" THE Plunger button BACK.  Then place 

the tip against the inside of the container in which you wish to place the liquid.  Depress the plunger 

button past first stop and down to the second stop.  The extra pressure will allow of the liquid in the 

pipet tip to be ejected.   NOTE: IF YOU DEPRESS THE PLUNGER BUTTON TO THE 

SECOND STOP WHEN YOU DRAW THE LIQUID UP INTO THE TIP, YOU WILL HAVE 

MORE THAN THE CALIBRATED VOLUME. 

 

 

C. Measuring Volume with a Graduated Cylinder 

 

1. Take a 100 or 150 ml beaker and fill it about half full with the red colored liquid in a flask at 

your station.  The liquid is just water with some food coloring added to it so you can see the 

liquid easily.  Note that while the stock flask or the beaker may have markings on their sides, 

these values are only approximate and are never to be used for an actual measurement.  Pour the 

liquid into a 100 ml graduated cylinder.  Look at the meniscus, measure the volume.  Record the 

results below.  
 

volume of red liquid: __________ 

 

Figure 1.5. Micropipetter Stop Positions 
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2. To test the accuracy of this measurement, place a clean dry beaker on the top-loading balance 

and reset it to 0.00 g.  Pour the liquid into the beaker and measure the mass in grams.  Record the 

weight of liquid below.  The density of pure water is 1.00 g/cm
3
 or 1.00 g/ml.  How far off was 

the graduated cylinder?  
 

weight of red liquid: __________ 
 

3. difference between weight as determined by volume and weight as determined on the balance: 

______________ 
 

D. Measuring Volume with a Pipet 
 

1. Now fit a 10 ml serological pipet with a green pipet pump.  Draw some of the liquid up into the 

pipet and look at it carefully.  Rotate the wheel and then transfer 10.0 ml of this liquid back into 

the original container. 

 

2. Repeat this process with volumes of 6.7, 5.8, 4.2, and 3.1 ml.  Note that you can use the 

markings anywhere along the pipet to transfer a certain volume.  For example, 6.7 ml could be 

measured from 1.0 to 7.7 ml or from 2.5 to 9.2 ml or from 3.3 to 10.0 ml. 

 

3. Once you have figured out how to read the markings correctly, place a clean dry beaker on the 

top-loading balance and reset it to 0.00.  Using the pipet, transfer 6.7 ml of liquid to the beaker 

and measure the mass in g.  The transfer will be most accurate if you touch the tip of the pipet to 

the glass and allow the liquid to run into the container.   

 

4. Repeat the process nine more times and record your values below.  Use the tare function to reset 

the balance to 0.00 after adding each sample.  Then calculate the arithmetic mean or average 

value of the mass of liquid.  Also calculate the variance and the standard deviation.  Record the 

results in a chart like that shown below. 
 

          Transfer of 6.7 ml 

Replicate Weight (g) 
1  

2  

3  

4  

5  

6  

7  

8  

9  

10  
 

mean   =  __________ 

 

variance   =  __________ 

 

standard deviation  =  __________ 
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E. Measuring Volume with Micropipetters 

 

1.  practice transferring liquids with a micropipetter, set a P-1000 to 1 0 0 0 (1000 l = 1.0 ml) and 

place a pipet tip firmly on the end.  Depress the piston to the first stop and slowly draw some of 

the red liquid up into the pipet tip.  Be careful not to get any air bubbles in the tip.  Now place 

the tip against the side of a beaker and depress the piston down to the first stop and then down to 

the second stop.  Watch the liquid flow out of the pipet tip. 

 

2. To test the accuracy of the pipetter, set the P-1000 to 460 l (4 6 0).  Place a plastic weighing dish 

on the top loading balance, and transfer 10 replicate samples of the red liquid to the dish.  

Measure the weight after adding each sample to the dish and record the results in the following 

table.  Use the tare function to reset the balance to 0.00 after adding each sample.  Calculate the 

mean, the variance, and the standard deviation.   Record the results the chart shown on the next 

page. 

 
             Transfer of 460 µl 
 

Replicate Weight (g) 

1  

2  

3  

4  

5  

6  

7  

8  

9  

10  
 

mean   =  __________ 

 

variance   =  __________ 

 

standard deviation =  __________ 
 

 

3. Now repeat this process using the P-100 micropipetters.  For these pipetters, be sure to use the 

smaller plastic tips.  Pick a specific volume to use (from 10 μl to 100 μl for the P-100) and 

measure the weight of 10 replicate samples. Use the tare function to reset the balance to 0.00 

after adding each sample.  Record the results in the chart on the following page and calculate the 

mean, the variance, and the standard deviation. 
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P-100 volume  =  _________   
 

Replicate Weight (g) 

1  

2  

3  

4  

5  

6  

7  

8  

9  

10  
 

mean   =  __________ 
 

variance   =  __________ 
 

standard deviation =  __________ 

 
 

F. Preparing Solutions 
 

In this course, most of the solutions you will need for the experiments will be prepared for you in 

advance.  However, you still will need to understand the meaning of the concentration units given on 

each solution and to have a sense of how that solution might be prepared. 

 

1. Concentrations 

 

a. The term concentration refers to the amount of a solute in a solution.  Concentrations can be 

expressed in several ways. Because solid solutes may contribute to the final volume of 

solution, solutions containing large amounts of solute are usually made up by the dissolving 

the solid in a smaller volume and then making the solution up to the designated total volume. 

 

b. Weight/Volume solutions.  A weight/volume solution is one in which a concentration is 

expressed as the amount of a solute in a certain volume.  Weight/volume solutions usually 

have units of mg/ml or g/ml for small volumes or g/l for large volumes.  For example, a 

solution in which 5 mg of a solute is dissolved in 10 ml of water has a concentration 5 mg/10 

ml or 0.5 mg/ml.  A solution in which 25 g of a solute is dissolved in 1000 ml of water has a 

concentration of 25 g/l, which can also be expressed as 25 mg/ml. 

 

c. Molar solutions.  A molar solution is one in which the concentration of a solute is expressed 

in terms of the number of moles of that solute in a total volume of 1 liter (1000 ml).  A 

solution in which 58.44 g of NaCl is dissolved in a total volume of 1000 ml has a 

concentration of 1.0 M.  For solutions containing smaller amounts of solutes, concentrations 

may be expressed as mM (millimolar) or M (micromolar).  For example, a solution in which 

0.058 g (58 mg = 1 millimole) of NaCl is dissolved in a total volume of 1000 ml has a 

concentration of 0.001 M or 1.0 mM. 

 

d. Percent solutions.  A percent solution is one in which the concentration of a solute is 

expressed as a percentage of a total of 100 parts.  For liquids, percent concentrations are 
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usually given in terms of a volume/volume ratio.  50 ml of solute in a total volume of 100 is a 

50% solution; 1 ml of solute in a total volume of 100 ml is a 1% solution.  For solids, percent 

concentrations are usually given as a weight/volume ratio.  A solution in which 25 g of solute 

is dissolved in a total volume of 100 ml is a 25% solution; a solution in which 2 g is 

dissolved in a total volume of 1000 ml is a 0.2% solution. 

 

2. Solution Calculations  

 

Solutions are usually prepared by dissolving a certain amount of a solute in a particular solvent.  

While percentage solutions can be prepared using English units (for example, 1 pound of solute in 1 

gallon of solution), most solutions in biology are prepared using metric units.  Solutions of a 

particular molarity are prepared by 1) calculating the amount of solute needed to prepare a particular 

volume of solution at a specified molarity; 2) weighing out the desired amount of solute and 

dissolving in the desired solvent; and 3) making the final solution up to the desired total volume. 

 

For example, suppose you are told to make 0.5 liter of a 0.25 M solution of Calcium Chloride, which 

has a gram molecular weight of 111.  You can calculate the needed amount of calcium chloride as 

follows: 

 

0.5 liter x 0.25 mole x 111 g  = 13.88 g  

liter   mole 

 

Notice that the desired volume is multiplied by the desired concentration, which is then multiplied 

by a conversion factor relating weight to moles.  The unneeded units cancel out, so that the final 

value is expressed in grams.   

 

a. What is the concentration of this solution in mmoles/l?  

 

0.25 mole x  1000 millimole = 250 millimole  

liter   1 mole    liter 

 

=  250 mM 

 

b. How many mg of calcium chloride would you use to make only 5 ml of solution? 

 

5 ml x 0.25 mole x l liter       x  111 g     x 1000 mg 

liter   1000 ml mole  1 g 

 

= 138 mg 

 

 

3.  Problems. Record your complete calculations in your lab notebook. 

 

a. How many g of NaCl (gram molecular weight = 58.44) should you use to make 100 ml of a 

0.37 M solution? 

 

b. How many g of NaCl should you use to make 37 ml of a 1.0 M solution? 

 

c. How many g of NaCl should you use to make 5.8 l of a 3.7 mM solution? 
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d. If you have weighed out 5.84 g of NaCl, what would be the total volume of a 1.0 M solution? 

 

e. How much NaCl should you use to make 250 ml of a 5% solution? 

 

f. What percent solution would you have if you dissolved 3.7 g of NaCl in a total of 250 ml? 

 

g. If you dissolve 37 mg of NaCl in a total volume of 25 ml, what is the molar concentration?  

 

h. If you dissolve 5.84 g of NaCl in a total volume of 37 ml, what is the molar concentration? 

 

i. If you have a 10% solution of NaCl, what is its molar concentration?  

 

j. If you have a 2.5 M solution of NaCl, what is its percent? 

 

k. What is the concentration of a 0.025 M solution of NaCl in mg/ml? 

 

G. Making Dilutions 
 

1. Dilution Factors 

 

It is often convenient to prepare stock reagent solutions in a concentrated form and then dilute them 

for use in a particular experiment.  Likewise, it is often necessary in determining the amount of 

material in an unknown solution to test several different dilutions of it.  The liquid (for example, 

water) that is used to dilute a stock solution or an unknown solution is called the diluent.  The 

amount of dilution or the dilution factor can be defined in several ways, but the most useful method 

is in terms of the ratio: 

 

initial volume of solution  

final volume of solution  

 

For example, if 2.5 ml of a stock solution is combined with 7.5 ml of water, the dilution factor is 1/4: 

 

2.5 ml                      =    2.5 ml =    1 

2.5 ml + 7.5 ml  10.0 ml     4  

 

Dilutions are often made serially, that is, by making several dilutions sequentially.  Suppose that 1.0 

ml of an unknown solution is added to 2.0 ml of diluent; this makes a 1/3 dilution.  If 1.0 ml of this 

1/3 dilution is then added to another tube containing 2.0 ml of diluent, this makes a 1/3 dilution of a 

1/3 dilution or a 1/9 dilution.  If 1.0 ml of the 1/9 dilution is added to another tube containing 2.0 ml 

of diluent, this makes a 1/3 dilution of a 1/9 dilution or a 1/27 dilution.  Note that sequential dilution 

factors are multiplied to give the final dilution factor.   

 

Suppose you add 1.0 ml of a sample to 9.0 ml of water.  You then make 4 serial 1/2 dilutions of this 

solution.  What is the final dilution factor? 

 

1/10 x 1/2 x 1/2 x 1/2 x 1/2 = 1/160 
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2. Making Serial Dilutions 
 

a. Obtain 6 16 x 150 mm tubes and label them 1, 2, 3, 4, 5, and 6.  Using a green pipet pump 

and a 5 ml pipet, add 5.0 ml of water to each of the tubes.  In this exercise, water is the 

diluent. 
 

b. Using green pipet pump and another 5 ml pipet, add 5.0 ml of the red liquid to the first tube 

to make a 1/2 dilution.  Mix the solution carefully by drawing the liquid up and down in the 

pipet.   
 

c. Now add 5.0 ml of the liquid in tube 1 to tube 2 and mix the solution by drawing the liquid 

up and down in the pipet.  What is the dilution factor in this tube?   
 

__________ 
 

d. Continue the process until you have made all six dilutions.  Record the total dilution factor 

for each tube and note the change in the intensity of the color.   
 

Tube Total Dilution Factor 
1  

2  

3  

4  

5  

6  
 

e. Now obtain 4 clean 16 x 150 mm and label them 1, 2, 3, and 4.  Using a green pipet pump 

and a 10 ml pipet, add 9.0 ml of water to each of the tubes. 
 

f. Using a P-1000 micropipetter and a tip, add 1000 μl or 1.0 ml of the red liquid from the 

flask on your bench to the first tube.  Mix the solution carefully by drawing the liquid up and 

down in the pipet.  What is the dilution factor in this tube? 
 

__________ 
 

g. Now add 1000 μl or 1.0 ml of the solution in the first tube to the second tube.  What is the 

dilution factor in this tube?  Continue the process of making serial dilutions until you have 

made all four dilutions.  Record the total dilution factor for each tube and note the 

change in the intensity of the color.   
 

Tube Total Dilution Factor 
1  

2  

3  

4  
 

h. How quickly did the color dilute out in the 1/10 dilutions compared to the 1/2 dilutions?  

Which tube in the 1/2 dilution series has a color intensity most similar to the second tube in 

the 1/10 dilution series?  Which tube in the 1/10 dilution series has a color intensity to the 

last tube in the 1/2 dilution series?  Why does this make sense? 
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III. Using a Standard Curve 

 
A. What is a standard curve? 

 

A standard curve is a graph that shows the relationship between the amount of a particular compound in 

a solution and the absorbance of that solution.  This absorbance may be an intrinsic property of the 

molecules of interest or it may result from treating the molecules of interest with a particular set of 

reagents.  A standard curve is constructed by setting up a series of solutions that contain varying 

amounts of the compound of interest in exactly the same volume.  The amount of a compound may be 

expressed in molar units (for example, nmoles or μmoles) or in weight units (μg or mg).  The 

absorbance of each solution is then measured against a reference solution or blank that lacks the 

compound of interest.  The absorbance values of the solutions are then plotted as a function of the 

amount of compound (Figure 1.6)   

In most standard curves, there are both linear and nonlinear regions.  In the linear region, the absorbance 

increases in direct proportion to the amount of the compound of interest.  Within this region, it is quite 

easy to interpolate between the data points and to infer the amount of the compound of interest in any 

similar solution of known absorbance.  In the nonlinear region, however, the relationship between 

absorbance and amount is not simple and interpolation between the data points is more difficult.  

Nonlinearity in a standard curve can result from the loss of sensitivity of the instrument at high 

concentrations of the compound of interest or from a failure to completely convert the compound of 

interest to a detectable material.   

  

  

Figure 1.6. A typical standard curve. Shown is a standard curve for a 

color-forming quantitative reaction. 
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B. Using a standard curve 

 

Once a standard curve has been created, it can be used to determine the amount of the compound 

of interest in an unknown solution.  The absorbance of this unknown solution is first measured using 

the same instrument at the same wavelength as the standards.  There are then two ways to estimate the 

actual amount.  One is graphically.  That is, you can simply find the absorbance on the Y axis, move 

over to the linear region of the standard curve, and then read down to the X axis to get the corresponding 

amount.  The other is mathematically.  You can use the equation for the linear region of the standard 

curve to create a conversion factor for relationship between absorbance and amount.  That is, within the 

linear region, the straight line has the formula 

 

  y = mx + b 

 

where m is the slope of the line and b is the Y intercept.  If b = 0, that is, the line goes through the origin 

at 0,0, you can use the slope of the line (m) as the conversion factor since it directly gives the 

relationship between x and y.  You can then divide the absorbance of the unknown sample by the 

conversion factor to determine the corresponding amount.  

 

For example, suppose you construct a standard curve for compound Z by setting up a series of tubes 

containing varying amounts of Z in μg and by measuring the absorbance of each tube.  Suppose you then 

determine the slope of the line and get the equation y = 0.062 x.  This means that y (the absorbance) 

increases by 0.062 for increment in x (the number of μg).  In other words, there is 0.062 A/μg.  If you 

then measure the absorbance of an unknown solution containing Z and find that the absorbance is 0.198, 

you can calculate that the number of μg of Z in this tube is: 

 

0.198 A x 1 μg  = 3.19 μg 

   0.063 A 

    

The graphical method is easiest if only a few values need to be determined.  The mathematical method is 

easiest if there are many values that need to be determined. 

 

1. Standard Curve Practice Problems (Record your complete calculations in your lab 

notebook) 
 

Use Figure 1.7 to answer the questions on the following page 

 

 
Figure 1.7. Sample Standard Curve 
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a. A sample of BSA of unknown concentration had an absorbance reading of 0.502 A. Using 

the graphical method of analysis, determine the approximate concentration of BSA in the 

unknown sample. 

 

 

b. A sample containing a mixture of proteins had an absorbance of 0.611 A. Using the graphical 

method of analysis, determine the approximate concentration of protein in the unknown 

sample.  

 

 

c. A sample contains a mixture of proteins at a concentration of 65 μg/μl. Using the BSA 

standard curve, what is the approximate absorbance reading you expect for this sample. 

 

 

d. A sample containing a mixture of proteins had an absorbance of 0.384. Using the 

mathematical method of analysis and the equation y = 0.0114x, determine the concentration 

of protein (in μg/μl) in the unknown sample.   

 

 

e. A sample containing a mixture of proteins had an absorbance of 0.477. Using the 

mathematical method of analysis and the equation y = 0.0114x, determine the concentration 

of protein (in μg/μl) in the unknown sample.   

 

VI. Using Excel 

 
As part of this laboratory course, you will need to process numerical data and prepare various types of 

graphs.  These graphs will be included in your Data Sheets and Lab Reports.  The third part of this lab 

session will focus on Excel, one commonly-available software package that can be used for these purposes.  

The most common versions of Excel used today are Excel 2007 and Excel 2010.  Although they allow you 

do many of the same things, the positions of the task buttons and the procedures for doing certain steps in 

preparing graphs may be slightly different.   

 
A. Introduction 
 

Excel is a spreadsheet, calculation, and graphics program that is part of the Office suite of software 

programs developed by Microsoft.  All of the computers on the ASU campus now have the Office 2010 

version of this program.  Most students will have this version on their home computer as well, although 

some people may still use the Office 2003 or 2007 version.  While Excel is not actually the best program 

for many scientific applications, it is commonly used at ASU and is sufficient for the laboratory work to 

be done in this course.   
 

The following are some links to free tutorials for using Excel 2010 and 2007  

 

Excel 2010 Tutorials 

http://office.microsoft.com/en-us/excel-help/getting-started-with-excel-2010-HA010370218.aspx 

http://www.gcflearnfree.org/excel2010/1 

 
 

 

http://office.microsoft.com/en-us/excel-help/getting-started-with-excel-2010-HA010370218.aspx
http://www.gcflearnfree.org/excel2010/1
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Excel 2007 Tutorials 

http://office.microsoft.com/en-us/training/HA102189871033.aspx 

http://www.fgcu.edu/support/office2007/Excel/Gettingstarted.asp 

 

The book by Karin Knisely mentioned on page 10 of the Student Lab Manual has a very good 

appendix on the use of Excel 2007 to make Graphs.  

 

Knisely, K. (2009) A Student Handbook for Writing in Biology, 3/e. Sinauer Associates/ W. H. 

Freeman and Company, Sunderland, MA. 

 

If you have a computer with Excel 2010 on it and are familiar with the software, you can jump ahead to 

the two exercises in Section C.  If you have not used Excel 2010 before or are unfamiliar with some of 

its features, you may want to purchase the Knisely book or spend some time with the tutorial links 

above. 

 

B. Excel Exercises 
 

The following two exercises are designed to help you learn to use the basic features of Excel that will be 

most important in this class.  As part of the first exercise, you will process some data related to seed 

weights and make a bar graph to summarize the results.  As part of the second exercise, you will analyze 

some data related to the length of the flagella on a protist called Chlamydomonas and make a scatter-plot 

of the results.  As with most software programs, there are several ways to do many of the steps, so do 

what is easiest for you. 
 

1. Exercise 1 (Include a copy of your graph in your lab manual) 

 

The data set 

 

a. Suppose that you do a series of weight measurements of various plant seeds like you did as 

part of Laboratory 1 using a balance that reads to 0.001 g (1 mg).  You obtain the following 

results.   

 

Pinto beans Lima Beans Great Northern Beans  Peas 

 

0.263  0.895  0.562    0.188 

0.278  0.951  0.549    0.134 

0.246  1.004  0.565    0.142 

0.255  0.875  0.534    0.122 

0.279  0.953  0.597    0.152 

0.261  0.804  0.539    0.102 

0.249  0.837  0.548    0.143 

0.252  0.984  0.535    0.139 

0.285  1.017  0.561    0.153 

0.917  0.573    0.136 

 

b. To analyze these results, you will first calculate the mean, the standard deviation, and the 

variance for each type of seed.  You will then display results graphically as a bar graph. 

 

 

 

http://office.microsoft.com/en-us/training/HA102189871033.aspx
http://www.fgcu.edu/support/office2007/Excel/Gettingstarted.asp
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Numerical calculations 
 

a. Open Excel 2010 for Windows on your computer; be aware that if you are using a different 

version of Windows or Excel for Mac the detailed instructions here may not work the same 

way as are suggested.  You will see a worksheet consisting of a series of rows and columns.  

You will also see a Ribbon across the top which has a series of Tabs labeled Home, Insert, 

Page Layouts, Formulas, Data, Review, and View.  When you click on each of the Tabs, a 

series of additional menu options will appear. 
 

b. Enter the data for the pinto beans in cells A1 to A10, the data for lima beans in cells B1 to 

B10, the data for Great Northern Beans in cells C1 to C10, and the data for peas in cells D1 

to D10.   In order to save time, you can also use the prepared worksheet containing these 

data, which is available on the Blackboard course web site. 
 

c. To calculate the Mean or Average for the Pinto Beans, move the cursor down to cell A12 and 

click once.  The outline of the cell will appear in bold.  From the list of tabs at the top, click 

on Formulas.  This will bring up a new Tool Bar.  Click on Insert Function (fx) on the left end 

of the tool bar.  From the list of options in the dialog box, select AVERAGE and click OK.  

This will bring up a new box.  Enter A1:A10 in the box labeled Number 1 to designate the 

cells with the numbers to be included in the average.  Click OK.  You also can start with the 

cursor in the A1 cell and scan down to the A10 cell.  The set of cells will be outlined with a 

dotted line.  You also can insert =AVERAGE(A1:A10) in cell A12 or into the fx function bar 

at the top.  In each case, you should get the same result.  Repeat the process to calculate the 

Average of each of the other sets of seeds. 
 

d. To calculate the Standard Deviation for the Pinto Beans, move the cursor down to cell A13 

and click on it.  The outline of the cell will appear in bold.  From the list of Tabs at the top, 

click on Formulas.  This will bring up a new Tool Bar.  Click on Insert Function (fx) on the 

left end of the tool bar.  This will bring up a new box. Enter STANDARD DEVIATION in 

the box under Search for a Function and click GO. From the list of options in the box, select 

STDEV and click OK.  This will bring up a new box.  You can enter A1:A10 in box 

Number1 to designate the cells with the numbers to be included in the standard deviation 

calculation.  Click OK.  You also can start with the cursor in the A1 cell and scan down to 

the A10 cell.  The set of cells will be outlined with a dotted line.  You also can insert 

=STDEV(A1:A10) in cell A13 or into the fx function bar at the top.  Repeat the process to 

calculate the Standard Deviations of each of the other sets of seeds. 
 

e. To calculate the Variance for the Pinto Beans, move the cursor sown to cell A14.  The 

outline of the cell will appear in bold.  From the list of Tabs at the top, click on Formulas.  

This will bring up a new Tool Bar.  Click on the More Functions button and then go over to 

Statistical.  Scroll down the list of functions to VAR.S.  Click on it to insert this function.  

Again enter A1:A10 in box Number1 and click OK.  You can also scroll over the cells that 

you want to include and click OK.  Alternatively, you can type =VAR.S(A1:A10) in cell A14 

or into the fx function bar at the top or you can type  =A13*A13.  This means to multiple the 

value of the standard deviation by itself, which will give you the variance.  Repeat the 

process to calculate the Variance for each of the other sets of seeds. 
 

f. Finally, enter the names of various seeds in cells A11, B11, C11, and D11 as pinto beans, 

lima beans, GN beans, and peas.  To save your worksheet with these calculations, click on 

the FILE button at the top.  Click on the SAVE AS function and save the worksheet with the 

filename Excel Exercise 1 somewhere convenient on your computer. 
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Preparation of a bar graph 

 

a. To make a bar graph of these data, click on the Insert tab in the ribbon at the top.  You will 

see a series of options.  In the section labeled Charts, click on the tab labeled Column.  Then 

click on the 2-D column graph on the upper left-hand side.  A blank chart will appear on the 

worksheet.  Then click on the Design tab under Chart Tools.  Click on the box labeled Select 

Data.  A new box will appear.  Enter =Sheet1!$A$11:$D$12 in the box to indicate that the 

names and means of the various seed weights are to be included in the chart.  You can also 

use the cursor to scan across cells A11, B11, C11, D11, A12, B12, C12, and D12 to identify 

these cells as the basis of the chart.  Click OK. When you do this, a series of blue bars will 

appear on the Chart.  These will be identified as Series 1.  The names of the seeds will appear 

along the X axis. 

 

b. To add errors bars to the bar graph, click on the chart.  Then click on the Layout tab under 

Chart Tools.  Then click on the Error Bars box in the section labeled Analysis on the right 

side of this menu.  Go down to the bottom and click on More Error Bar options.  For vertical 

error bars, click on the Both Direction button at the top.  Then click on the custom button at 

the bottom.  Click on the specify value box.  A new dialog box will appear.  For the positive 

error bar values, select the standard deviations in cells A13, B13, C13, and D13 which you 

have already calculated.   You can insert =Sheet1!$A$13:$D$13 or scan across the cells as 

before.  In the same way, insert the same function into the negative error bar values.  Click 

OK.  The error bars will appear on your graph. 

 

c. The rest of the manipulation of the chart layout can be done either on the worksheet itself or 

on a separate sheet.  If you want to create a sheet with the chart alone, go back to the Design 

tab under Chart Tools.  On the right hand side, there is box says Move Chart.  Click on this 

box and place the chart on a new sheet labeled Chart 1.  Then click OK.  At this point, you 

will have a full-size chart to work with.  You can manipulate many of the features of the 

Chart by clicking on the Layout tab.  You can add a chart title, label the axes, change the 

fonts, remove gridlines, position the tick marks inside or outside the axes, and so on.  Most of 

these formatting issues are matters of personal preference.  In most scientific papers, chart 

titles are not used and information about the chart or graph is presented in a figure legend 

which is printed below the chart.  Once a graph like this has been completed, it can be copied 

and pasted directly into a Word document.  Here is one version of a chart based on the data 

provided in this exercise.  
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2. Exercise 2 (Include a copy of your graph in your lab manual) 

 

The data set 
a. When these organisms are exposed to a low pH of 4.5, the flagella fall off and movement 

stops.  If the pH is then restored to a pH of 7.0, the flagella regenerate (Figure 1.8).  The 

process of flagellar growth can be seen microscopically in a good light microscope.  

Eventually, the flagella are long enough that active motility resumes.  Suppose that you treat 

a culture of Chlamydomonas acetic acid to lower the pH and then after 30 seconds, restore 

the pH to about 7.0 with a dilute solution of KOH.  You place the deflagellated protists in a 

flask in a nutrient medium and then remove samples every 10 minutes for a total of 60 

minutes.  You place the samples in a fixative solution to stop further metabolism and 

preserve the cells.  You then make a slide of the protists in each sample and measure the 

length of the flagella on 10-15 different cells.  You obtain the following results, where the 

numbers in the table are in μm.  Note: the cells in each column are not same cells each time 

because they are different samples from the main culture. 

 

Time (minutes) 

0  10  20  30  40  50  60 

 

1  3  4  7  12  16  25 

2  2  6  8  11  18  23 

0  1  4  10  15  9  24 

1  3  5  1  8  19  19  

0  2  7  5  9  14  20 

0  4  6  8  11  17  19 

1  1  1  9  10  17  15 

3  2  5  6  13  15  22  

0  3  6  7  12  20  21 

1  2  4  5  10  18  19 

2  2  7  9  3  14  20 

1  3  6  6  12  13  21 

0  3  5  8    18  16 

2    9    21 

11 

Figure 1.8. Chlamydomonas is a unicellular 

protist that moves using its two flagella. 
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b. To analyze these results, you will first calculate the mean, the standard deviation, and the 

variance for each time point during the regeneration process.  You will then display results 

graphically as a scatter plot and put a trendline onto the graph. 

 

Numerical calculations  

 

a. Click on the File button in Excel and open a new workbook (Click on New followed by 

Blank Workbook).  Again, you will see worksheet consisting of a series of rows and 

columns.  Enter the data for the 0 time sample in the A column, the data for the 10 minute 

sample in the B column, and so on.  In order to save time, you can also use the prepared 

worksheet which is available on the Blackboard course web site. 

 

b. Calculate the Mean for each of the samples as you did in Exercise 1 and enter the results in 

cells A17, B17, C17, D17, E17, F17, and G17.  Calculate the Standard Deviation for each of 

the samples as you did in Exercise 1 and enter the results in cells A18, B18, C18, D18, E18, 

F18, and G18.  Finally, enter the times at which the samples were taken in cells A16, B16, 

C16, D16, E16, F16, and G16.    

 

c. To save your worksheet with these calculations, click on the FILE button at the top.  Click on 

the SAVE AS function and save the worksheet with the filename Excel Exercise 2 

somewhere convenient on your computer. 

 

Preparation of a scatter plot 

 

a. To make a scatter plot or a dot plot, click on the Insert tab in the ribbon at the top.  You will 

see a series of options.  In the section labeled Charts, click on the tab labeled Scatter.  Then 

click on the graph in the upper left hand corner.  A blank chart will appear on the worksheet.  

Then click on the Design tab under Chart Tools.  Click on the box labeled Select Data.  A 

new box will appear.  ='Sheet1'!$A$16:$G$17 in the box to indicate that the times and means 

of the flagellar lengths.  You can also use the cursor to scan across cells A16 to G16 and A17 

to G17 to identify these cells as the basis of the chart.  Click OK. When you do this, a series 

of blue dots will appear on the Chart.  These will be identified as Series 1.  The times will 

appear along the X axis. 

 

b. To add errors bars to the bar graph, click on the chart.  Then click on the Layout tab under 

Chart Tools.  Then click on the Error Bars box on the right side of this menu.  Go down to 

the bottom and click on More Error Bar options.  For vertical error bars, click on the Both 

Direction button at the top.  Then click on the custom button at the bottom.  Click on the 

specify value box.  A new dialog box will appear.  For the positive error bar values, select the 

standard deviations in cells A18, B18, C18, D18, E18, F18, and G18 which you have already 

calculated.   You can insert =Sheet1!$A$18:$G$18 or scan across the cells as before.  In the 

same way, insert the same function into the negative error bar values.  Click OK.  The 

vertical error bars will appear on your graph.  Close the Format Error Bars Dialog Box. 

Unfortunately, Excel also will sometimes automatically add horizontal error bars (relative to 

the time points) to the graph as well.  This will shift the scales on the X and Y axes.  

However, all of this can be fixed. 

 

c. The rest of the manipulation of the chart layout can be done outside of the worksheet.  Go 

back to the Design tab under Chart Tools.  On the right hand side, there is box says Move 

Chart.  Click on this box and place the chart on a new sheet labeled Chart 1.  Then click OK.  
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At this point, you will have a full-size chart to work with.  You can manipulate many of the 

features of the Chart by clicking on the Layout tab.  You can add a chart title, label the axes, 

change the fonts, remove gridlines, put the tick marks inside or outside, change the symbols, 

add a trendline, and so on.  Most of these formatting issues are matters of personal 

preference.  

 

d. The easiest way to make many of the more substantive changes is to use the Change Current 

Selection area in the upper left corner of the Format menu.  In this area, you can select (in the 

scroll-down menu) any of the major components of the graph.  Click first to identify what 

you want to work on and then click on Format Selection to change the features of that 

component.  For example, if you bring up the Horizontal Axis and click on Format selection, 

you can change the X axis scale so that it starts at 0.  Likewise you can change the Y axis 

scale so that it starts at 0.  To remove the horizontal error bars, bring up Series 1 X error bars 

and format this selection.  Set it to a fixed value of 0 and the error bars will go away.   

 

e. Click on the Layout menu and click on the Trendline tab to add a line to the data points.  In 

this case, it is easiest to click on more Trendline options.  You can then select a linear 

trendline and force the line to go through the origin at 0,0 (Enter 0.0 in the Set Intercept box).   

 

f. Once a graph like this has been completed, it can be copied and pasted directly into a Word 

document.  Here is one version of this graph.  It seems to indicate that there is a direct 

relationship between flagella and time, although a more complex function might also fit the 

data. 
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V. Answers to Practice Problems 
 

 

Interconversion of metric units  
 

a. 55 mm 

b. 550 cm 

c. 0.555 m 

d. 5.55 x 10
4
 cm 

e. 5.55 x 10
5
 nm 

f. 42 ml 

g. 4.2 x 10
4
 μl 

h. 0.42 l 

i. 0.754 μg 

j. 7.54 x 10
6
 ng 

k. 0.754 kg 

 

 

Interconversion of metric and English 

units  
 

a. 6.42 in 

b. 0.414 m 

c. 41.4 mm 

d. 5.35 ft 

e. 6.43 x 10
4
 mg 

f. 0.080 oz 

g. 1032 g 

h. 103 kg 

i. 1868 ml 

j. 747 l 

k. 7472 ml 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Preparation of Solutions  

 

a. 2.16 g 

b. 2.16 g 

c. 1.25 g 

d. 99.9 ml 

e. 12.5 g 

f. 1.48% 

g. 0.025 M 

h. 2.70 M 

i. 1.71 M 

j. 14.6% 

k. 1.46 mg/ml 

 

 

Standard Curve 

a. Approximately 50 μg/μl 

b. Approximately 60 μg/μl 

c. Approximately 0.7 A 

d. 33.68 μg/μl 

e. 41.84 μg/μl 

 

 
 


